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Tuyên b  b n quy nố ả ề

Giáo trình này s  d ng làm tài li u gi ng d y n i bử ụ ệ ả ạ ộ ộ 

trong tr ng Cao đ ng ngh  Công nghi p Hà N iườ ẳ ề ệ ộ

Tr ng Cao đ ng ngh  Công nghi p Hà N i không sườ ẳ ề ệ ộ ử 

d ng và không cho phép b t k  cá nhân hay t  ch c nào sụ ấ ỳ ổ ứ ử 

d ng giáo trình này v i m c đích kinh doanh.ụ ớ ụ

M i trích d n, s  d ng giáo trình này v i m c đích khácọ ẫ ử ụ ớ ụ  

hay   n i khác đ u ph i đ c s  đ ng ý b ng văn b n c aở ơ ề ả ượ ự ồ ằ ả ủ  

tr ng Cao đ ng ngh  Công nghi p Hà N iườ ẳ ề ệ ộ



BÀI 1: GI I THI U PH N M M FLASH VÀ THI T K  V  C  B NỚ Ệ Ầ Ề Ế Ế Ẽ Ơ Ả

1. Gi i thi u  ng d ng FLASHớ ệ ứ ụ

1.1 Các tính năng c a  ng d ngủ ứ ụ

T o ra các đ i  t ng chuy n đ ng, di chuy n qua khung Stage ( n i  trìnhạ ố ượ ể ộ ể ơ  
chi u)  ho c làm thay đ i  hình dáng (Shape),  kích  th c (Size),  màu s c (Color),ế ặ ổ ướ ắ  
h ng xoay (Rotation) và các thu c tính khác.ướ ộ

Flash cho phép t o ra các vùng chuy n c nh cho đo n phim mà trong đó ng iạ ể ả ạ ườ  
xem có th  s  d ng bàn phím hay chu t đ  nh y đ n t ng ph n khác nhau c a đo nể ử ụ ộ ể ả ế ừ ầ ủ ạ  
phim, di chuy n đ i t ng..ể ố ượ

T o  ra  vùng  chuy n  c nh  b ng  cách   thi t   l p   các  Action   (hành  vi)   dùngạ ể ả ằ ế ậ  
ActionScript.

1.2 Giao di n làm vi cệ ệ

a. Vùng Timeline

Ch a các khung hình chuy n đ ng:ứ ể ộ

Layer: B ng qu n lý l pả ả ớ

b. Vùng thanh công c   Toolsụ

Vùng thanh công c  ch a các công c  đ  t o hình, hi u ch nh và t o các hi uụ ứ ụ ể ạ ệ ỉ ạ ệ  
ng cho các đ i t ng.ứ ố ượ
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Hình 1.2.1 Thanh công cụ

c. Vùng thanh thu c tính Propertiesộ

M i m t đ i t ng đ u có thu c tính riêng nh  màu vi n, lo i vi n, màuỗ ộ ố ượ ề ộ ư ề ạ ề  
n n… Đ  qu n lý các thu c tính này, Flash b  trí chúng trong m t c a s  Properties.ề ể ả ộ ố ộ ử ổ

                                       Hình 1.2.1 Vùng thu c tínhộ

Thu c tính c a vùng so n th o Stage bao g m:ộ ủ ạ ả ồ

Publish:

Player: Cho phép trình chi u có th  ho t đ ng t t trên phiên b n Flash nào.ế ể ạ ộ ố ả

Script: Phiên b n ActionScript mà đo n phim đang s  d ng cho b n m t cúả ạ ử ụ ạ ộ  
pháp khai báo c a l p n i t i – m c đ nh là l p k  th a t  MovieClip.ủ ớ ộ ạ ặ ị ớ ế ừ ừ

Class: Nh p tên l p th  hi n vào, l p t c Flash s  kh i t o ậ ớ ể ệ ậ ứ ẽ ở ạ

Profile: Qu n lý các thông tin liên quan đ n vi c xu t b n d  án Flash.ả ế ệ ấ ả ự
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AIR Settings: Các c u hình thi t l p cho d  án Flash ch y trên Adobe Airấ ế ậ ự ạ

Properties: 

FPS:  T c đ  ch i – đo b ng s  frame trên m i giây Frames Per Second.ố ộ ơ ằ ố ỗ

Size : Kích th c c a khung chi u­ đo b ng pixel.ướ ủ ế ằ

Stage: Qu n lý màu n n c a khung so n th o.ả ề ủ ạ ả

d. Vùng so n th o ActionScriptạ ả

Hi n th  c a s  Action : Windows / Action (F9)ể ị ử ổ

Ph n so n th o n m   trung tâm c a c a s  này. Vùng phía bên trái ch a cácầ ạ ả ằ ở ủ ử ổ ứ  
l p th  vi n và cây ph  h  ( mô t  s  k  th a c a các l p). Phía trên khung so nớ ư ệ ả ệ ả ự ế ừ ủ ớ ạ  
th o là h  th ng các công c  h  tr  so n th oả ệ ố ụ ỗ ợ ạ ả  ActionScript.

(1): B  sung các thành ph n vào c a s  ActionScriptổ ầ ử ổ

(2): Tìm ki m và thay th .ế ế

(3): Chèn target path. Ch c năng này th ng đ c s  d ng khi làm vi c v i l p.ứ ườ ượ ử ụ ệ ớ ớ
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(4): Ki m tra l i cú pháp.ể ỗ

(5): Đ nh d ng cho mã ngu n theo ch  đ  t  đ ng c a ActionScript.ị ạ ồ ế ộ ự ộ ủ

(6): Xem các ch  d n v  mã ngu n.ỉ ẫ ề ồ

(7): T o các ki m thoát khi debug ch ng trình.ạ ể ươ

(8): Đóng m  các kh i mã l nh ch ng trìnhở ố ệ ươ

(9): H  tr  khi vi t scriptỗ ợ ế

1.3 Thi t l p môi tr ng làm vi cế ậ ườ ệ

a. T o m i tài li u Flash ạ ớ ệ

Ho c vào File > Neặ w, và có th  nh n Ctrl+N.ể ấ
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Hình 1.3.1: T o m i tài li u Flashạ ớ ệ

Khi t o m i m t d  án trong Flash, chúng ta c n quan tâm đ n m t s  ki u dạ ớ ộ ự ầ ế ộ ố ể ự 
án sau đây:

ActionScript 3.0: T o d  án h  tr  ActionScript 3.0. D  án này s  d ng choạ ự ỗ ợ ự ử ụ  
Flash Player và Flash Plugin v i n n t ng ch  y u là Desktop.ớ ề ả ủ ế

ActionScript 2.0: Phiên b n đ c h  tr  2.0.ả ượ ỗ ợ

Adobe Air : T o d  án Flash cho Desktop ho c các thi t b  khác có h  trạ ự ặ ế ị ỗ ợ 
Adobe Air.

AIR for Android: T o d  án Flash ch y trên AIR ph c v  cho các thi t b  sạ ự ạ ụ ụ ế ị ử 
d ng h  đi u hành Android c a Google.ụ ệ ề ủ

AIR for iOS : T o d  án Flash ch y trên AIR ph c v  cho các thi t b  s  d ngạ ự ạ ụ ụ ế ị ử ụ  
h  đi u hành iOS c a Apple. iOS SDK c a Apple ch  cung c p cho các nhà phát tri nệ ề ủ ủ ỉ ấ ể  
s  d ng n n t ng MacOS.ử ụ ề ả

Flash Lite 4,  Adobe Device Central:  T o d  án Flash cho Mobile ch y trênạ ự ạ  
Flash Lite. H  tr  trên các dòng đi n tho i.ỗ ợ ệ ạ

b. Thi t l p các thu c tính m t tài li u  ­ Setting Document Propertiesế ậ ộ ộ ệ

Modify / Document

Cách hai là ta nh n Ctrl+J, c  hai cách đ u làm xu t hi n b ng thu c tính .ấ ả ề ấ ệ ả ộ
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Hình 1.3.2: Thu c tính trang tài li uộ ệ

Dimention: Thông th ng là: 800 x 600,ườ   t i đa có th  đ t: 2880 x 2880 pixel vàố ể ặ  
nh  nh t là 1x1 pixel,ỏ ấ

Backgound color: Đ t màu n nặ ề

Frame Rate ; 24 fps : t c đ  film.ố ộ  v.v... 

c. L u tài li u ­ Saving a Documentư ệ

File Flash l u(Save) v i ph n đuôi m  r ng là .fla: ư ớ ầ ở ộ

File­> Save, Crtl+S. 

N u mu n l u sang m t th  m c,   đĩa khác: File>Save as ho c Ctrl+Shift+Sế ố ư ộ ư ụ ổ ặ
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Hình 1.3.3: L u tài li uư ệ

M t s  phím t t th ng dùngộ ố ắ ườ
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2. Các đ i t ng c  b n ố ượ ơ ả

2.1 Các đ i t ng trong trang ho t hình ố ượ ạ

a. Công c  Selectionụ  (V)

Công c  ch n đ i t ng ho c m t ph n đ i t ng b ng cách kích đôi chu tụ ọ ố ượ ặ ộ ầ ố ượ ằ ộ  
vào nó ho c bôi đen m t ph n đ i t ng. Công c  cho phép kéo giãn, u n các biênặ ộ ầ ố ượ ụ ố  
c a hình th  ( Đ t con  tr  và các biên c a hình và nó có d ng nh  bi u  t ngủ ể ặ ỏ ủ ạ ư ể ượ  
Selection b  sung thêm đ ng cong màu đen.ổ ườ

Chú ý: Đ  ch n nhi u đ i t ng gi  phím Shift.ể ọ ề ố ượ ữ

Hình 2.1a: Công c  Selectionụ

b. Công c  SubSelection (A)ụ  
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Hình 2.1b: Công c  Subselectionụ

Nh p ch n bi u t ng SubSelection, sau đó b m vào đ i  t ng.  Khi đóấ ọ ể ượ ấ ố ượ  
đ ng vi n c a đ i t ng s  hi n ra các đ ng Bezier c u thành nên v t th . Cácườ ề ủ ố ượ ẽ ệ ườ ấ ậ ể  
đi m đánh d u b ng ch m tròn đ c g i là các đi m đi u khi n đ ng Bezier.ể ấ ằ ấ ượ ọ ể ề ể ườ

c. Công c  Free Transform (Q) ụ

Tree Transform Tool (Q)

Công c  tinh ch nh góc c nh, xoay đ i t ng.ụ ỉ ạ ố ượ

Cách s  d ng : Ch n bi u t ng trên thanh công c , ch n đ i t ng c n hi uử ụ ọ ể ượ ụ ọ ố ượ ầ ệ  
ch nh.ỉ

Mu n phóng to hay thu nh  đ i t ng, ta ch  đ t tr  chu t các nút đ i t ngố ỏ ố ượ ỉ ặ ỏ ộ ố ượ  
kéo ra ngoài n u mu n tăng kích th c, kéo vào trong n u mu n gi m kích th c.ế ố ướ ế ố ả ướ  
N u mu n xoay đ i t ng, ta nh n vào nút góc c a đ i t ng.ế ố ố ượ ấ ủ ố ượ
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Hình 2.1c1: Công c  Free Transformụ

Hình 2.1.c2:  Thay đ i tâmổ  
quay c a đ i t ngủ ố ượ

Gradient Transform Tool (F)

Công c  hi u ch nh các thông s  khi đ  màu chuy n s c cho đ i t ng, ta b mụ ệ ỉ ố ổ ể ắ ố ượ ấ  
ch n vào bi u t ng tam giác đen trên công c  Free Transform, lúc này xu t hi nọ ể ượ ụ ấ ệ  
công c  Gradient Transform, b n ch  vi c b m nó.ụ ạ ỉ ệ ấ
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Hình 2.1.c3: Công c  Gradient Transformụ

Sau đó, b m chu t vào vùng chuy n s c. Trên vùng màu này, s  hi n raấ ộ ể ắ ẽ ệ  
m t d ng th c đ  màu nh  hình trên. Hi u ch nh bao c a khung màu này nh : kéoộ ạ ứ ổ ư ệ ỉ ủ ư  
to ( tăng kích th c vùng sáng), thu nh  (gi m kích th c vùng sáng), b m vào nútướ ỏ ả ướ ấ  
tròn và d ch chuy n nó ( thay đ i vùng màu)ị ể ổ

d. Công c  Lasso (L) ụ

T ng t  nh  công c  Selection. Công c  Lasso cũng cho phép ch n.ươ ự ư ụ ụ ọ

Công c  Lasso có th  ch n theo hình d ng ph c t p. Lasso không dùng đ  tinhụ ể ọ ạ ứ ạ ể  
ch nh đ i t ng. Khi b m bi u t ng này, xu t hi n thêm các công c  con bao g mỉ ố ượ ấ ể ượ ấ ệ ụ ồ  
Wand, Magic Wand và Polygon Mode.

Hình 2.1d: Công c  Lassoụ

Magic Wand là công c  ch n nhanh. Khi s  d ng công c  này ta c n hi u ch nhụ ọ ử ụ ụ ầ ệ ỉ  
m t s  thông s  trong m c Magic Wand Setting: threshold – s  pixel cho phép sai sộ ố ố ụ ố ố 
khi ch n, smoothing – cách làm m t nét ch n ( bao g m: pixel, rough, normal vàọ ượ ọ ồ  
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smoothing )

Polygon Mode là công c  cho phép ch n theo đ ng g p khúc ph c t pụ ọ ườ ấ ứ ạ

Đây là công c  dùng đ  ch n trong tình hu ng đòi h i đ  chính xác, t  m  đ  xụ ể ọ ố ỏ ộ ỉ ỉ ể ử 
lý. Ch  đ c áp d ng v i các đ i t ng đ c v  b ng Flash.ỉ ượ ụ ớ ố ượ ượ ẽ ằ

e. Nhóm công c  Penụ  

Công c  Pen Tool  (P) ụ

Công c  dùng đ  v  các đ ng đa giác b ng cách t o ra các đi m đi u khi n,ụ ể ẽ ườ ằ ạ ể ề ể  
sau đó t  đ ng n i các đi m này l i v i nhau.ự ộ ố ể ạ ớ

Mu n t o hình th  d ng đ ng th ng ta ch  c n nh p nút đ u và nút cu iố ạ ể ạ ườ ẳ ỉ ầ ấ ầ ố

Hình 2.1e1: Công c  Penụ

Công c  Add Anchor Point (=):  ụ B  sung thêm đi m đi u khi n cho đ ngổ ể ề ể ườ  
Bezier. Mu n b  sung đi m đi u khi n ch n công c  sau đó b m vào m t v  trí trênố ổ ể ề ể ọ ụ ấ ộ ị  
đ ng biên.ườ

Công c  Delete Anchor Point (­): ụ Xoá b t đi m đi u khi n cho đ ng Bezier.ớ ể ề ể ườ  
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Mu n xoá đi m đi u khi n ch n công c  sau đó b m vào m t đi m đi u khi n c nố ể ề ể ọ ụ ấ ộ ể ề ể ầ  
xoá b .ỏ

Chú ý: Vi c b  sung và xoá b  các đi m đi u khi n r t h u ích trong vi c t o cácệ ổ ỏ ể ề ể ấ ữ ệ ạ  

đ ng u n. Ví d : Đ i t ng Parabol, ta ch  c n b n đi m đi u khi nườ ố ụ ố ượ ỉ ầ ố ể ề ể

Các đi m đi u khi n là các đi m n m trên đ ng biênể ề ể ể ằ ườ

Hình 2.1e2: Hình các đi m đi u khi nể ề ể

Công c  Convert Anchor Point (C): ụ Dùng đ  chuy n đ i vùng đi u khi n gócể ể ổ ề ể  
c nh thành đi m u n cong.ạ ể ố

Đ  chuy n đ i đi m đi u khi n góc c nh thành đi m u n cong, ta ch  vi cể ể ổ ể ề ể ạ ể ố ỉ ệ  
ch n công c  và nh p vào đi m c n chuy n đ i. Đ  hi u ch nh góc xoay cho cácọ ụ ấ ể ầ ể ổ ể ệ ỉ  
đ ng đi u khi n, ta ch  vi c xoay các đ ng đi u khi n.ườ ề ể ỉ ệ ườ ề ể

Hình 2.1e3: Công c  Convert Anchor Pointụ

f. Công c  Text (T)ụ  
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Là công c  dùng đ  so n th o n i dung văn b n trong Flash.ụ ể ạ ả ộ ả

Text Tool: Có 3 lo i:ạ

Static Text: Văn b n c  đ nh nh  n i dung c a Label trong l p trình h ng đ i ả ố ị ư ộ ủ ậ ướ ố
t ng.ượ

Dynamic Text: Văn b n có th  ch n, copy nh ng không thay đ i nh  n i dung ả ể ọ ư ổ ư ộ
c a TextBox khi hi u ch nh thu c tính Readonly = True.ủ ệ ỉ ộ

Input Text: N i dung văn b n có th  thay đ i nh  n i dung c a TextBox khi ộ ả ể ổ ư ộ ủ
thu c tính Readonly = False.ộ

Character: Family: Ch n Font ch .ọ ữ

Style: Ch n d ng th c cho Font ch  in đ m , in nghiêng.ọ ạ ứ ữ ậ

Size : Ch n kích th c cho Font ch .ọ ướ ữ

Letter Spacing: Ch n đ  r ng cho kí t  tr ng gi a các ch  cái.ọ ộ ộ ự ắ ữ ữ

Color: Ch n màu cho Font ch .ọ ữ

Anti­ Alias: Làm cho nét ch  tr  nên m t h n.ữ ở ượ ơ

Hình 2.1f: Công c  Textụ

Show Border around Text: Hi n th  đ ng vi n xung quanh văn b n.ể ị ườ ề ả

SubScript và SuperScrip: T o ch  s  d i (ki u xạ ỉ ố ướ ể 2) và ch  s  trên (ki u xỉ ố ể 2)
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Format: Căn ch nh văn b nỉ ả

Spacing và Margin: Spacing hi u ch nh kho ng cách c a các t  trong văn b n ệ ỉ ả ủ ừ ả
ho c các dòng văn b n. Margin hi u ch nh kho ng cách bên trái ho c bên ph i c a ặ ả ệ ỉ ả ặ ả ủ
n i dung văn b n so v i vi n bên ngoài.ộ ả ớ ề

g. Công c  Line Tool (N)ụ  

Là công c  v  đ ng th ng. Khi b m vào bi u t ng này trên thanh thu c tính ụ ẽ ườ ẳ ấ ể ượ ộ
s  hi n các thông s  liên quan.ẽ ệ ố

Hình  2.1g: Công cụ 
Line

Stroke color: Ch n màu cho đ ng th ng.ọ ườ ẳ

 Stroke: Kích th c c a nét v .ướ ủ ẽ

 Style: D ng th c c a nét v .ạ ứ ủ ẽ

  Scale : Kéo dãn hình đ c v .ượ ẽ

  Hinting: Giúp b o v  nét v    đ ng cong kh i b  m .ả ệ ẽ ở ườ ỏ ị ờ

  Cap: Thi t l p d ng th c cho các đ ng k t thúc.ế ậ ạ ứ ườ ế

  Join : Xác đ nh cách mà hai phân đo n c a đ i t ng n i v i nhau.ị ạ ủ ố ượ ố ớ

   Mitter : Đi u khi n đ  s c nét c a Mitter.ề ể ộ ắ ủ

h. Công c  Rectangle Tool (R)ụ  

Công c  này dùng đ  v  hình ch  nh t và các d ng bi n th  c a nó.ụ ể ẽ ữ ậ ạ ế ể ủ

Thu c tính Properties chú ý đ n các thu c tính sau:ộ ế ộ
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Stroke color: Ch n màu vi n cho nét v .ọ ề ẽ

Fill color : Ch n màu n n cho nét v .ọ ề ẽ

Stroke : Kích th c c a nét v .ướ ủ ẽ

Style:   D ng th c c a nét v .ạ ứ ủ ẽ

Scale: T  l  nét vỉ ệ ẽ

Hình 2.1.h1: Công c  Rectangle Toolụ

Công c  Oval Tool (ụ o) 

V  các hình Oval, khi b m ch n bi u t ng tam giác nh    phía d i bi u t ngẽ ấ ọ ể ượ ỏ ở ướ ể ượ  
Rectangle, s  xu t hi n bi u t ng Oval này.ẽ ấ ệ ể ượ

Hình 2.1.h2: Công c  Oval Toolụ
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Các thu c tính t ng t  nh  công c  Rectangle Toolộ ươ ự ư ụ

Công c  Rectangle Primitive Tool (Rụ )

Công c  cho phép hi u ch nh góc tròn hình ch  nh t. Đây là  u đi m c a công cụ ệ ỉ ữ ậ ư ể ủ ụ 
này.

Hình 2.1.h3: Công c  Rectangle Primitive ụ

Công c  Oval Primitive Tool (oụ ) 

T ng t  nh  công c  Oval. Ngoài ra ta có th  hi u ch nh các thu c tính góc m , gócươ ự ư ụ ể ệ ỉ ộ ở  
đóng, bán kính c a hình vành khăn.ủ
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Hình 2.1.h4: Công c  Oval Primitive ụ

Công c  PolyStar Tool :ụ

Dùng đ  v  đa giác và hình sao. Khi b m ch n công c  này, ta chú ý các tu  ch nể ẽ ấ ọ ụ ỳ ọ  
trong b ng thu c tính Properties.ả ộ

Fill color: Ch n màu n n cho v t th .ọ ề ậ ể

Stroke color: Ch n màu vi n cho nét v .ọ ề ẽ

Hình 2.1.h5: Công c  ụ PolyStar Tool

i. Công c  Pencil Tool (Y)ụ  

Dùng đ  v  các đ i t ng b ng tay. Các thu c tính  ng v i công c  Pencil là:ể ẽ ố ượ ằ ộ ứ ớ ụ

Stroke color : Màu c a nét v .ủ ẽ

Stroke : Kích th c c a nét v .ướ ủ ẽ

Style : D ng th c c a nét v ­ đ ng li n nét, đ t nét..ạ ứ ủ ẽ ườ ề ứ

Scale : T  l  nét v .ỉ ệ ẽ

Hinting : Giúp b o v  nét v    đ ng cong b  m .ả ệ ẽ ở ườ ị ờ

Cap. Thi t l p d ng th c cho đ ng k t thúc.ế ậ ạ ứ ườ ế
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Join : Xác đ nh cách mà hai phân đo n c a đ i t ng n i v i nhau.ị ạ ủ ố ượ ố ớ

Mitter : Đi u khi n đ  s c nét c a Mitter, khi Cap đ c ch n Mitter.ề ể ộ ắ ủ ượ ọ

Hình 2.1.h5: Công c  ụ Pencil Tool 

j. Công c  Brush Tool (B)ụ  

Cũng t ng t  công c  Pencil, Brush đ c dùng đ  v . Có s  khác bi t là nétươ ự ụ ượ ể ẽ ự ệ  
v  c a Brush không bao g m ch  có màu n n, còn Pencil ng c l i ch  có màu vi nẽ ủ ồ ỉ ề ượ ạ ỉ ề  
không có n n. Các thu c tính c a Brush bao g m:ề ộ ủ ồ

Fill color : Ch n màu cho nét v .ọ ẽ

Smoothing: Đ  m m cho nét v .ộ ề ẽ

k. Công c  Spray Brush Tool (B)ụ  

Công c  phun màu trong Flash. Chúng ta có th  đ nh nghĩa m u màu đ  phun,ụ ể ị ẫ ể  
các ch  đ  phun màu: Góc nghiêng, đ  r ng, đ  cao, ch  đ  xoay các bi u t ngế ộ ộ ộ ộ ế ộ ể ượ  
theo góc ng u nhiên…ẫ

2.2 Kh  năng thi t k  các ho t c nh ả ế ế ạ ả

2.3 Qu n lý các đ i t ng b ng c a s  Libraryả ố ượ ằ ử ổ

Library là th  vi n qu n lý các đ i t ng đ c Import và Convert. Đ  convertư ệ ả ố ượ ượ ể  
m t đ i t ng kích chu t ph i vào đ i t ng ch n Convert to Symbol. Khi đó bi uộ ố ượ ộ ả ố ượ ọ ể  
t ng s  xu t hi n trong Libraryượ ẽ ấ ệ
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Import m t đ i t ng t  bên ngoài vào Library ­>File­> Import­> Import toộ ố ượ ừ  
Library. Các đ i t ng đ c ch n đ a vào Library:ố ượ ượ ọ ư

Ch nọ  Window > Library ho c nh n phím Ctrl+L, ho c m  nhanh nh n phímặ ấ ặ ở ấ  
F11.
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Các đ i t ng n m trong th  vi n đ c t  ch c và qu n lý theo c u trúc câyố ượ ằ ư ệ ượ ổ ứ ả ấ  
th  m c. Đ  t  ch c và qu n lý theo cây th  m c, ta c n t o m i th  m c theo c uư ụ ể ổ ứ ả ư ụ ầ ạ ớ ư ụ ấ  
trúc c a Windows Explorer.ủ

Th  vi n Flash cho phép ta th c hi n thao tác kéo th  các đ i t ng t  v  tríư ệ ự ệ ả ố ượ ừ ị  
này sang v  trí khácị

3. Phân c nhả

3.1 Khái ni m phân c nh.ệ ả

Đ c hi u nh  các c nh quay trong Flash. M t c nh quay là t p h p c a cácượ ể ư ả ộ ả ậ ợ ủ  
khung hình k  ti p nhau đ  t o ra các chuy n đ ng.ế ế ể ạ ể ộ

3.2 Cách t o phân c nh.ạ ả

Insert / Insert Scence
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Các c nh quay t o ra các th c phim dài. M t c nh quay trong Flash cũngả ạ ướ ộ ả  
gi ng nh  m t c nh quay trong truy n hình. Khi c n m t th c phim hoàn ch nh,ố ư ộ ả ề ầ ộ ướ ỉ  
chúng ta có th  ghép n i nhi u c nh quay l i v i nhau. ể ố ề ả ạ ớ

Chú ý: Hi n th  b ng Scene : Windows ­>Panels­>Sceneể ị ả

3.3 S p x p và hi u ch nh phân c nhắ ế ệ ỉ ả

C nh quay đ c ghép t  đ ng theo th  t  đã s p x p. Mu n thay đ i th  tả ượ ự ộ ứ ự ắ ế ố ổ ứ ự 
c nh quayả

Mu n làm xu t hi n c a s  qu n lý các c nh quay.ố ấ ệ ử ổ ả ả

Windows/ Other/ Panels/ Scene (Shift +F2)

S p x p c nh quay b ng thao tác kéo th . Th  t  c nh quay s  di n ra theoắ ế ả ằ ả ứ ự ả ẽ ễ  
th  t  t  trên xu ng d i.ứ ự ừ ố ướ

Khi xây d ng c nh quay đ c l p. Ki m tra t ng c nh quay b ng cách Control /ự ả ộ ậ ể ừ ả ằ  
Test Scene (Ctrl+ Alt + Enter)
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Phím t t tắ rong ph n nàyầ
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Phím t tắ K t quế ả
Ctrl+ F8 T o bi u t ng m iạ ể ượ ớ
Ctrl+ Alt + B Ki m tra nút nh n ngay trên Stageể ấ
Ctrl+ Alt + Enter Ki m tra ho t hình ngay trên phân c nh hi n hànhể ạ ả ệ
Shift + F2 M  b ng ki m soát phân c nhở ả ể ả
Home Tr  l i phân c nh đ u tiênở ạ ả ầ
Page Up Tr  l i phân c nh tr c đóở ạ ả ướ
Page Down Đi t i phân c nh ti p theoớ ả ế
End Đi t i phân c nh cu i cùngớ ả ố



BÀI 2: T O CHUY N Đ NGẠ Ể Ộ

1. Thi t k  ho t hình ế ế ạ

1.1 Các đ i t ng đo nố ượ ạ

1.2 Các đ i t ng nút ố ượ

1.3 Gán hành đ ng b ng ộ ằ

Timeline hay còn g i là b ng ti n trình: Ch a các khung hình (Frame), các l pọ ả ế ứ ớ  
(Layer), các phân c nh (Scene). Ta s  d ng b ng ti n trình (Timeline) đ  t  ch c vàả ử ụ ả ế ể ổ ứ  
ki m soát phim.ể

•Playhead: Ch  ra khung hình ­ Frame hi n th i trên Stage ( sân kh u­ trang v )ỉ ệ ờ ấ ẽ

Timeline Header: là thanh ch a s  khung hình đ c đánh s  t  Frame1 tr  lênứ ố ượ ố ừ ở  
(s  khung hình nhi u không có gi i h n có th  t i hàng ngàn).ố ề ớ ạ ể ớ

Timeline Status ­ Thanh tr ng thái ch  s  khung hình hi n th i,  t c đ  c aạ ỉ ố ệ ờ ố ộ ủ  
khung hình(Frame Rate)

Layer­ L p: T ng t  nh  nh ng t m film, trong su t ch ng khít lên nhau. Taớ ươ ự ư ư ấ ố ồ  
có th  thêm m t layer m i, xóa b t layer, khóa l p...ể ộ ớ ớ ớ

Frame: Khung hình đ c  chia   t ng   ng v i  s  khung hình bên  trên.  M iượ ươ ứ ớ ố ỗ  
khung hình có th  ch a m t hay nhi u đ i t ng ho t hình.ể ứ ộ ề ố ượ ạ
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Playhead­Con tr  khungỏ  hình

Scene­Phân c nhả Timeline Header ­ S  khung hìnhố

Frame­khung hìnhLayer­L pớ

Timeline Status ­ Thanh tr ng tháiạ



M t s  ch c năng khi làm vi c v i TimeLine:ộ ố ứ ệ ớ

Phím F5: Chèn Frame vào thanh TimeLine t ng  ng v i Insert Frame.ươ ứ ớ

Phím F6: Chèn KeyFrame vào thanh TimeLine t ng  ng v i Insert Key Frame.ươ ứ ớ

2. Bi n đ i v  trí hình vế ổ ị ẽ  

2.1 T o các hình vạ ẽ

S  d ng các công c  v  trên thanh công c  đ  t o ra các hình v .ử ụ ụ ẽ ụ ể ạ ẽ

2.2 Bi n đ i theo Tweeningế ổ

Kh i t o m t KeyFrame đ u tiênở ạ ộ ầ
Sau đó nh n F8: Bi n đ i t ng thành Movie Clip t i Name: Đ t tên đ i t ngấ ế ố ượ ạ ặ ố ượ

Nh n F6 t i  KeyFrame 40.ấ ạ
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Nh n   chu t   ph i   vào   đo n   gi a   KeyFrame   đ u   tiên   và   KeyFrame:   Ch n   Creatấ ộ ả ạ ữ ầ ọ  
Motion Tween: 

Nh n Ctrl + Enter. Test k t qu .ấ ế ả

2.3 Trình t  các b c bi n đ i ự ướ ế ổ

2.4 Ví d   ng d ngụ ứ ụ

3. S  bi n đ i hình d ng hình v  ự ế ổ ạ ẽ

3.1 Các yêu c u c a bi n đ i hình vầ ủ ế ổ ẽ

3.2 Bi n đ i theo Shape ế ổ

3.3 Trình t  các b c bi n đ iự ướ ế ổ

4.  Phép xoay hình

4.1 Cách t o phép xoay hìnhạ

4.2 Trình t  phép xoay hìnhự

4.3 Ví d   ng d ngụ ứ ụ
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BÀI 3: LÀM VI C V I L PỆ Ớ Ớ

1. L p và thi t l p l pớ ế ậ ớ

1.1 Ý nghĩa c a l pủ ớ

M i m t đ i   t ng th ng đ c xây d ng trên m t  l p  (layer).  M i m tỗ ộ ố ượ ườ ượ ự ộ ớ ỗ ộ  
khung hình có th  ch a nhi u layer khác nhau. K  thu t layer đ c s  d ng r ng rãiể ứ ề ỹ ậ ượ ử ụ ộ  
trong đ  h a máy tính.ồ ọ

1.2 Thi t l p l pế ậ ớ

Có 3 cách đ  t o layer m iể ạ ớ
* Kích vào nút Inset Layer
* Ch n Inset>ọ Timline>Layer 

Ch n layer mu n thêm, nh n nút ph i chu t và ch n Inset Layer t  menu .ọ ố ấ ả ộ ọ ừ

Xóa layer ­ Delete Layer
* Ch n l p c n xóa, nh n vào nút Delete Layerọ ớ ầ ấ

Ch n l p c  xóa, nh n ph i chu t, ch n Delete Layerọ ớ ầ ấ ả ộ ọ          t  menu ng  c nh.ừ ữ ả
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 Bi u t ng th  nh t t  trái sang: T o m i Layerể ượ ứ ấ ừ ạ ớ
Bi u t ng th  hai: T o m i th  m c đ  ch a layer.ể ượ ứ ạ ớ ư ụ ể ứ
Bi u t ng th  ba: Xóa layer ho c th  m c ch a layer.ể ượ ứ ặ ư ụ ứ

T  ch c l p ­ Organizing  Layerổ ứ ớ
* Thêm th  m c l p : Nh n vào nút thêm th  muc.ư ụ ớ ấ ư
* Đ a m t l p vào trong th  muc: Ch n l p mu n di chuy n, kéo lênư ộ ớ ư ọ ớ ố ể  

trên th  m c, th  phím chu t ra, l p s  đ c chuy n vào trong th  muc.ư ụ ả ộ ớ ẽ ượ ể ư
* Đ t l i tên cho l p: Nh p đúp vào l p mu n đ i tên, Đ t l i tên m i vào.ặ ạ ớ ấ ớ ố ổ ặ ạ ớ

Đ t l i tên cho th  m c : Làm t ng t  nh  làm v i l pặ ạ ư ụ ươ ự ư ớ ớ

Thu g n và m  r ng th  m cọ ở ộ ư ụ
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Thêm l p m iớ ớ

Thêm l p d nớ ẫ

Thêm  Th   m c ư ụ
l p Folderớ

Xoá l pớ



Nh p vào bi u t ng Expand ấ ể ượ      đ  m  r ng ể ở ộ ho c Collape ặ       đ  thu g n.ể ọ

1.3 Hi u ch nh l pệ ỉ ớ

 Bi u t ng th  nh t t  trái sang:  n hay hi n Layer đóể ượ ứ ấ ừ Ẩ ệ
Bi u t ng th  hai: Khóa không cho phép ch nh s a đ i t ng trên layer.ể ượ ứ ỉ ử ố ượ
Bi u t ng th  ba: Hi n th  đ ng vi n màu n n.ể ượ ứ ể ị ườ ề ề

2. L p m t nớ ặ ạ

2.1  ng d ng l p m t nỨ ụ ớ ặ ạ

Dùng đ  thi t l p vùng hi n th  tùy ý các hình  nh   các l p b  che n m d iể ế ậ ể ị ả ở ớ ị ằ ướ  
(Masked layer  ) qua m t khuôn hình   l p m t n    trên (mask Layer ộ ở ớ ặ ạ ở ). Trong kỹ 
thu t này bao gi  cũng có c u trúc nh  sau: layer mask   trên cùng và m t hay nhi uậ ờ ấ ư ở ộ ề  
l p b  che n m   d i ch a hình  nh n n c n hi n th .ớ ị ằ ở ướ ứ ả ề ầ ể ị

B ng cách thêm vào các chuy n đ ng cho l p mask hay các l p b  che, ta cóằ ể ộ ớ ớ ị  
th  t o ra nhi u hi u  ng thú v  nh  hi u  ng đèn pha, kính lúp, ch p x­quangể ạ ề ệ ứ ị ư ệ ứ ụ
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2.2 Cách t o l p m t nạ ớ ặ ạ

L p m t n  ch  liên k t v i l p n m ngay d i nó. M t n  che ph  các đ iớ ặ ạ ỉ ế ớ ớ ằ ướ ặ ạ ủ ố  
t ng trên l p n m ngay bên d i.ượ ớ ằ ướ

Đ  t o l p m t n , ch n l p t o m t n  nh n ph i chu t và nh n Maskể ạ ớ ặ ạ ọ ớ ạ ặ ạ ấ ả ộ ấ

2.3 Hi u ch nh l p m t n   ệ ỉ ớ ặ ạ

3. L p đ ng d nớ ườ ẫ

3.1  ng d ng l p đ ng d nỨ ụ ớ ườ ẫ

3.2 Cách t o l p đ ng d nạ ớ ườ ẫ

3.3 Hi u ch nh l p đ ng d nệ ỉ ớ ườ ẫ
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BÀI 4: XÂY D NG CÁC ACTIONỰ

1. Làm vi c v i nútệ ớ

1.1 Cách t o nútạ

Trong Flash có 2 l p đ i t ng button:ớ ố ượ

Simple   Button:   L p   ng i   dùng   thi t   k   s   d ng   ch c   năng   Convert   toớ ườ ế ế ử ụ ứ  
Symbol.

L p Button còn l i s  d ng trong th  vi n fl.Controlsớ ạ ử ụ ư ệ

Cách t o m t button :ạ ộ

Ch n đ i t ng c n chuy n đ i sang Button.ọ ố ượ ầ ể ổ

Nh n F8 ho c kích chu t ph i / Convert to Symbol: Xu t hi n h p tho i:ấ ặ ộ ả ấ ệ ộ ạ

Trong m c Type: Ch n Buttonụ ọ

Chú ý: Có th  t o bi u t ng Button nhanh chóngể ạ ể ượ

S  d ng các Button đ c t o s n : Windows / Common Libraries / Buttonử ụ ượ ạ ẵ

S  d ng Commands: T o kh i hình th , nh p ch n nóử ụ ạ ố ể ấ ọ

Sau đó vào Commands / Make Button.

1.2 Các tính năng c a nútủ

Bi u t ng button dùng đ  b  sung t ng tác v i movie, đáp tr  các s  ki nể ượ ể ổ ươ ớ ả ự ệ  
kích chu t,  n phím, kéo các thanh kéo và hành đ ng khác.ộ ấ ộ

Bi u t ng button có 4 frame t ng tác: Up, Down, Over, Hit.ể ượ ươ
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1.3 Gán Action cho nút

Ch n nút c n gán Action.ọ ầ

Windows / Actions (F9)

2. Xây d ng ho t hình b ng Actionự ạ ằ

2.1 Làm vi c v i c a s  Actionệ ớ ử ổ

Đ  hi n th  b ng action: Ch n Window>Action, ho c nh n F9, b ng action sể ệ ị ả ọ ặ ấ ả ẽ 
xu t hình nh  hình d i:ấ ư ướ
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2.2 Gán Action lên các Frame

Đ  hi n th  b ng Action: ể ể ị ả

Ch n khung Frame ọ

Windows / Action (F9)

2.3 Các c u trúc Action c  b nấ ơ ả

3. Th  vi n Actionư ệ

3.1 Nhóm Autoplay
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M t s  phím t tộ ố ắ

3.2  Nhóm 
KeyPress

C n ph i gán cho Button Intances m t s  ki n key pressầ ả ộ ự ệ  
b ng t  “on” vi d :́ằ ừ ụ
on(keyPress   “<Enter>”)
{ gotoAndPlay(1);
}
M t  vài  key   trên  bàn  phim nh   sau:    Entéộ ư r,  Escape,  Up,  Down,  Left,  Right, 
Backspace...

3.3 Nhóm Goto  
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